
 I Can Present Green Screening - Windows ! Page 1 

https://www.kudlian.net/Kudlian_Software/AnimateItSupportWin.html
https://www.kudlian.net/Kudlian_Software/AnimateItSupportWin.html
https://www.kudlian.net/Kudlian_Software/AnimateItSupportWin.html


Introduction 4

System Requirements 5

Additional Requirements 5

Installing the Software 5

Getting Started 6

The Main Window 6

Creating and Editing Slides 7

Adding Slides 7

Deleting Slides 7

Pick a Background Colour for a Slide 8

Importing Pictures to Slides 8

Import from PDF 9

Pick from library 9

Adding Symbols to a Slide 10

Deleting a Symbol 10

Changing the Symbol Size 10

Editing Symbols 10

Temperature 11

Left and Right Justified Pin Labels 11

Wind Speed 11

UV Categories 11

Pollen Levels 12

Sport Symbols 13

Project Settings 14

Show a Watermark 14

Show a news ticker 14

Show a time stamp 15

Changing the Temperature Scale 15

Writing a Script 16

The Recording Studio 17

Supported Cameras 18

Camera and Microphone 18

Video Quality 19

Settings 20

 I Can Present Green Screening - Windows ! Page 2 



Microphone Only 20

Getting Your ‘Studio’ Ready to Record 21

Recording Layouts 21

Chroma Key (Green Screen) 21

Split Screen 23

Picture in Picture 23

Script - Teleprompt 23

Recording 24

Exporting a Movie 25

Loading and Saving Files 26

Saving an I Can Present File 26

Opening an I Can Present File 26

Chroma Key 27

Tolerance 27

Smoothness 27

Chroma Keying Explained 28

Lighting 29

Appendix 31

Links to Support Resources and Updates 31

Deploying I Can Present Over a Network 31

Acknowledgements
31

 I Can Present Green Screening - Windows ! Page 3 



Introduction

• I Can Present is an exciting way to present information as a video. Using ‘Green Screen‘

techniques, also know as chroma key, you can create and film your own presentations

quickly and easily and then export a movie that gives similar results to those on the TV.

• I Can Present has been designed to ensure that with little previous experience, you’ll be

creating great looking presentation straight away.

• Create a series of slides choosing different backgrounds or import your own pictures.

• You can also add symbols by dragging them onto a slide. A variety of symbols are

provided for various presentations.

• Add your own script. Enter your script into the teleprompter which automatically scrolls as

you record your presentation.

• When you’re ready for filming and you can choose to set up either for green screening, or

for an outside studio broadcast.

• Movies are saved in a format that can be viewed on almost all computer systems and can

also be imported into third-party post production tools where they can be prepared for

publication for use on websites, entrance hall presentation screens and much more.

• We have also added in features that allow you to include news ticker and watermark.

• You can now bring presentations to life with I Can Present in your classroom.

This guide is for Version 2.0.0 or later. 

Author: Roger Young MSc, Cert Ed. 
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System Requirements

A PC running either Windows XP SP 3, Vista SP1, Windows 7, Windows 8, Windows 10

CPU: Intel Pentium 4, 3 GHz / Athlon XP 3200+ equivalent or later.

Disk Space: 100MB of free hard disc space

Memory: 2 GB RAM, preferably minimum of 4GB

Video Card; Although not a requirement, this is strongly recommended for best results.

• 128 MB video memory

• Requires shader model 2.0

• DirectX 9 compatible recommended

If your video card does not meet the above specification then you can still use the application 

to create and edit the slides.

You are recommended to install the demonstration version before purchasing I Can Present in 

order to test your system, cameras and microphones.

Additional Requirements

A suitable USB web camera or firewire DV camcorder. You hardware may require an 

additional firewire card to use a DV camcorder.

We recommend the use of a chroma key screen to get the most from this software. Visit the 

Kudlian Soft Website http://www.kudlian.net for a range of solutions.

Installing the Software

I Can Present can be downloaded directly through our website. All updates are provided 

through our website. Network installers for Windows, and guides for installation, can be found 

in the support section on the I Can Present website.

It is a good idea to download the installer before running it. You will require admin access 

rights to complete the installation. Follow the prompts that appear on screen from the 

installer.

The I Can Present application requires Microsoft .NET 3.5 Framework SP1 to be installed. If 

this is not present then the I Can Present installer will prompt you to download and install it.

If you wish to deploy the application over a network please refer to these notes in the 

Appendix or those on our website.

By default, the application will be installed into:

C:\Program Files\Kudlian Soft\I Can Present
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Getting Started

• To launch I Can Present choose the application from the Start > Programs menu.

Note: If you are intending to record your presentation straight away, it is a good idea to have 

your camera plugged into the computer and switched on before launching I Can Present.

The Main Window

I Can Present has two main windows:

• The Slide Editor – Create and edit slides

• Recording Studio – Set up and record video

I Can Present starts by displaying the Slide Editor.

Tool Bar

Preview AreaTimeline

Tool Panel

Slides
I Can Present
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Creating and Editing Slides

Across the top of the screen is the Toolbar giving you access to the different features. By 

default you should have the Slide background selected.

Slide backgrounds are the pictures you are going to use in the presentation. A few are 

supplied as examples. You can use any suitable pictures but make sure the pictures are as 

high a quality as possible as these will display better in your presentation.

Adding Slides

By default there will be one blank slide already in the 

slide view. 

1. Decide which type of background you wish to use 

in your slide. You can choose from four options;

• Colour - Allows you to select the background 

colour from the colour palette.

• Choose Picture - opens a filer window to allow 

you to choose any picture.

• PDF - opens a filer window to allow you to 

choose a PDF file. This could be a PowerPoint 

slide.

• Pick from Library - These are the example 

backgrounds supplied with I Can Present.

2. Click the + button to add a new slide 

3. The new slide automatically becomes selected and will be displayed in the preview area.

Deleting Slides

1. Select the slide to be deleted in the slide view at the bottom of the window.

2. Either click the – button or right click over the slide and choose Delete from the 

pop-up menu. The slide will be removed from your project.

If you have made a mistake and decide that you did not want the slide deleted, then it can be 

easily restored as I Can Present supports multiple undo and redo. This can be accessed 

through the Edit menu.

• Choose Edit > Undo from the menu bar to undo the deletion or use the keyboard 

shortcuts, Ctrl Z for undo and Ctrl Y for redo.
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Pick a Background Colour for a Slide

A slide in the timeline can have a solid background colour instead of a picture.

1. Select a slide in the timeline to apply the colour to.

2. Click the Pick Colour button to open the colour palette.

3. Select a colour from the Colour palette or choose a custom colour.

4. Click OK to apply the colour.

Importing Pictures to Slides

You can import most pictures into I Can Present as already indicated. 

1. Select a frame in the timeline at the bottom of the screen.

2. Click the Choose Picture button.

3. A File Open dialogue will prompt you to navigate to the location of the picture file that 

you wish to import.

4. Select the file and click Open.

You then need to select the region of your image that you wish to display. I Can Present will 

allow you to import any picture.

Importing a picture

The ‘wire’ frame shows the area that will be used in your imported image. I Can Present will 

display this in the correct aspect ratio during your presentation.

Use the mouse to resize and position the frame to select the region to import.
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5. Click OK to finish importing the image.

The image will be added to the currently selected frame in the timeline.

If this is not the background that you require at the beginning of your presentation then refer 

to the sections on deleting and adding backgrounds.

Import from PDF

You can import PDF files to use as backgrounds for your presentation. This is especially 

useful as it allows you to export and use files from PowerPoint presentations for example. 

PowerPoint slides are exported in Landscape format and are ideal for using in I Can Present. 

If you import a portrait oriented PDF, it will be cropped to fit, as in the example below. 

When a PDF file is imported import works differently from other background modifying 

buttons. The PDF import creates a new slide for each page in the pdf. 

If the last slide in the project is blank, remove it, in fact any blank slide can be deleted.

Pick from library

Example graphics files are installed with I Can Present. By default this folder is installed to;

 C:\Program Files\Kudlian Soft\I Can Present\Data\Library Images

To access these pictures;

• Click the Pick from library button.

A browser window will open allowing you to choose a folder and from within this, the picture 

file you wish to use.

 I Can Present Green Screening - Windows ! Page 9 



Adding Symbols to a Slide

The symbols are grouped by type and each group can be selected by clicking on the drop 

down menu. Symbols can be added to any slide. 

There is a specific set of weather symbols that can be used in conjunction with the Maps that 

are installed in library.

To add a symbol:

• Click the Symbols button in the tool bar.

The Symbols Tool panel will be displayed.

• Click the disclosure arrow and from the drop down menu,

choose a symbol set to use in your presentation

To place a symbol on your slide:

• Click and drag the symbol from the tool panel to the your slide

in the preview area.

Don’t worry if it is not exactly correct as you can move them 

around by clicking and dragging later.

Some symbols will animate once they have been dragged onto the 

slide.

Deleting a Symbol

• Click on the symbol you wish to delete in the preview window,

and then drag the symbol off the slide and release the mouse

button.

Changing the Symbol Size

The size of symbols placed on the slide can be 

changed. This action will change the size of all the 

symbols on the current slide.

• Click on the Symbol size slider and drag it to the

right to increase the size of the symbols and to the

left to decrease the size.

Editing Symbols

Some symbols can be edited, for example temperature symbols. 
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Once the symbol has been dragged to the preview window, double clicking it allows you to 

edit any text in the symbol.

The editable symbols are Temperature, Wind Speed, Labels and UV.

Temperature

• Drag and drop the temperature symbol onto the slide in the preview window.

By default temperatures are displayed in degrees 

centigrade.

I Can Present can be reconfigured to use a 

temperature range in degrees Fahrenheit. By 

default if installed to a computer with region set to 

US, the default will be in degrees Fahrenheit.

Double click the temperature symbol, and type in 

the value you require. The colour of the symbol will change according to the temperature you 

enter.

Temperature Scale

Left and Right Justified Pin Labels

These labels have a drop pin that can be placed at a particular 

location. When you then double click on the label’s text it will 

become highlighted and you can then enter the text of your 

choice.

Wind Speed

The wind speed symbol can be changed in a similar way to all other 

editable symbols.

1. Drag and drop the wind speed symbol onto the slide.

2. Double click on the symbol, you can now enter your wind speed.

3. The symbol can also be rotated to show the wind direction.

4. Click and hold down the mouse button on the direction arrow, and rotate it until it points

in the required direction.Pollen

UV Categories

The UV symbol also has an editable field that is edited in the same way as the 

other symbols. This symbol changes colour depending on the values entered.
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Category UVI range Colour

Low
Moderate
High
Very high
Extreme

0 to 2 
3 to 5
6 to 7
8 to 10
≥ 11

Green
Yellow
Orange
Red
Purple



The UV index shows the risk associated with being outside in the sun with uncovered and 

unprotected skin. Normally either shown as a coloured symbol or numerical value or both.

The range for UV symbols is shown in the table opposite;

It is important however to assess risk levels that you know your skin type.

WARNING: The table below is only a guideline and you should seek professional advice on 

your skin type to ascertain your risk. You should always take adequate protection against 

damaging your skin through exposure to UV.

Index White Skin
Easily Burnt

White Skin
Easily Tans

Brown 
Skin

Black Skin

 

low risk low risk low risk low risk

  

medium low low low

  

high medium low low

 

very high high medium medium

extremely 
high

high high medium

BBC Sun Index

Pollen Levels

The pollen symbol shows the level of pollen in the air. There are four levels of pollen count 

that you can place onto your slide.

! Low! Moderate! High! Very High
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Sport Symbols

Other symbols include a number of different sports symbol that 

can be used in conjunction with the backgrounds and other 

symbols.

These can be accessed by clicking on the drop down menu in 

the symbols library and choosing Sports from the list.

Drag and drop the symbol you require onto the slide. 

The symbol can be repositioned on the slide by selecting it with 

the mouse and dragging it to the new location.
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Project Settings

Click the Projects settings button in the Tool bar to open the settings panel.

Show a Watermark

This allows you to import and position a watermark on your presentation. The watermark 

could be a group, school, or company logo and can be positioned in one of the four corners 

of the screen. An Image with a transparency works well.

Click the Choose image button to access a browser window allowing you to navigate and 

select your logo.

Show a news ticker

Inserts a news ticker at the bottom of 

the screen and displays a writeable field 

where you can type your ‘stop press’ 

news bulletins or information.

Items placed on a separate line will be 

split in the news ticker by a bullet point.

I Can Present showing News ticker and watermark in the top left corner.

Breaking News ●  Earthquake 8.4 ● Temperatures soar into the h
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Show a time stamp

Adds a timestamp to the bottom of the screen. A writeable field allows you to insert any time 

you wish.

Changing the Temperature Scale

I Can Present is configured to start up using degrees centigrade, unless your computer is 

configured to the United States regional settings.

The settings panel allows you to change this manually for the project you are working on by 

clicking on either the Celsius or Fahrenheit radio buttons.

Values in the symbols will then be automatically converted.
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Writing a Script

I Can Present has an inbuilt teleprompter allowing you to enter a script for each individual 

slide. 

The text can be entered in any language, and may also be cut and pasted from 

another application.

1. Click on the Script button in the Tool bar.

An empty editable frame will appear in the Tool panel.

2. If you have already typed your text for the slide you are 

creating into a word processor, then copy and paste it 

into the teleprompter.

To paste text into the teleprompter once it has been copied 

from your text editor,;

• use the keyboard shortcut, Ctrl V

• or the Paste button under the script area, 

otherwise just type directly into the script frame. 

The text should contain information you are going to 

present for the currently displayed slide.

This might be an actual script or just bullet points to use as 

a prompt or reminder.

Each slide should have its own script. 

If you choose another slide from the Timeline, the script panel 

will change to display the script for the new slide.

The script will be used in the teleprompter and will automatically scroll when you use the 

Recording Studio as detailed in the next chapter.
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The Recording Studio

Once you have created your slides and written your script then it’s time 

to move to the Recording Studio.

Click the Recording Studio button located to the right hand side of the Tool bar.

This screen allows you to set up ‘your studio’ ready to begin recording.

Recording Studio, No devices selected

The toolbar at the top of the recording studio displays a number of controls that vary 

depending on which devices are available, for example either a camera and/or microphone.

If no devices are available then you are reminded that a camera and/or microphone need to 

be selected.

If your computer has an inbuilt microphone/camera then these can be used to record a 

presentation, otherwise you will need to plug an external camera/microphone into the 

appropriate ports on your computer and ensure that you have installed the correct drivers for 

them.
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Supported Cameras

I Can Present will work with any USB webcam* that has been correctly installed to the 

computer. Please ensure that you have installed any necessary drivers supplied with your 

camera.

 “What sort of web cam should I get?”

There are a number of things to consider when trying to decide which web cam is best to use 

with I Can Present. You are capturing real time video so a camera with a good frame rate at a 

high a screen size as possible is preferable. Fifteen frames per second (15fps) at 640 x 480 

would be a minimum specification, preferably 800 x 600 at 15fps, would be preferable. Some 

of the more modern webcams offer a full 30fps at HD. You will need to check the web cam 

specifications on the manufacturers website. If the camera is capturing any slower than the 

speeds suggested here the video capture might be less smooth.

We offer a number of cameras and our website, http://www.kudian.net, contains details of 

other cameras and how to set them up.

You can also use a DV camera that is connected via a firewire connection. Additional 

hardware may be required for computers not fitted with a firewire port and you will need to 

install any drivers supplied with the hardware. 

Please note that very few USB connected DV cameras currently have the ‘live feed’ feature 

that is required for a direct connection. Some cameras may be able to use a separate video 

capture device, but you would need to test with the trial software

The software should detect these devices when they are plugged into the computer. They will 

automatically appear in the drop down lists for devices. If this does not happen you may find 

it is necessary to have the devices plugged in and switched on before launching the 

application.

You could also use the HD camera in your iOS or Android mobile to capture your 

presentation using a really useful free App, EpoCam. Check out our website for the details of 

how to do this

Camera and Microphone

You can use either a good quality web camera connected to the USB port of your computer or 

a Digital Video (DV) camcorder connected through the firewire port. It is a good idea to have 

the camera connected, and if necessary, switched on before launching I Can Present.

You may also require an external microphone for good sound reproduction.

You should ensure that your subjects are well lit before starting shooting, this is especially 

important if you are using a chroma key screen.

If the camera does not automatically appear in the camera view, click on the drop down 

menu and choose the camera from the list.
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Toolbar with Camera Plugged-in

When a camera is plugged in and selected you will 

see the toolbar at the top of the recording studio 

window has additional drop down menus relating to 

the video settings. These settings are taken from 

the information supplied by the camera and 

consequently the information displayed may vary. If 

you use high settings you might find that your computer is not 

capable of processing quick enough. We have added some 

recommendations next to each setting.

Screen Size - This displays the screen sizes that the camera is 

able to capture. 640 x 480 should to be the lowest and we would 

advise 800 x 600 is a good setting. Some cameras may be able 

to use a larger screen size, but this might then impact on the 

number of frames per second that can be captured.

Frames per Second (fps)

fps is a measure of how much information is used to store and display motion video. The 

term applies equally to film video and digital video. Each frame is a still image; displaying 

frames in quick succession creates the illusion of motion. The more frames per second (fps), 

the smoother the motion appears. Television in the U.K, for example, is based on the PAL 

format, which displays 25 interlaced frames per second. Generally, the minimum fps needed 

to avoid jerky motion is about 30. Some computer video formats, such as AVI, provide only 

15 frames per second.

Early motion picture films used 18 frames per second and the current standard for movie 

films is 24 frames per second. A minimum of 15 fps is advised and the closer to 25fps, the 

better.

The number of frames per second that your camera is going to be able to capture might 

change depending on the screen size you have chosen, as can be seen in the example below.

Video Quality

This feature is especially useful as it controls the quality of the output video. During the 

capture of the video, the background will actually be displayed at whatever video quality is 

chosen irrespective of the capture video quality. This means that slides that contain text for 

example, will not be downgraded in quality in the final video. 
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In Picture in Picture the quality of the small captured video can be set quite low with a faster 

frame rate as the video display is quite small and quality will not really be noticed in the final 

output.

High Resolution Picture

640 x 480 at 25 fps
1080 HD Video out

Settings

The Settings button opens a control panel where you can flip the images horizontally and 

vertically and also control some features such asBrightness, Contrast, White BAlance, 

depending on what the camera allows you to do. Some cameras support a very limited set of 

features to control.

Microphone Only

If you do not have a camera then you can still use I Can Present to record your presentation. 

You can record the slides and accompany them with a 

voice over. 

• Select the microphone you wish to use from the 

drop down list of audio devices.

The microphones listed will include the microphone in your web cam. Although some 

microphones of this type will give good sound quality, you might like to connect an external 

microphone or radio microphone to the system.
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Getting Your ‘Studio’ Ready to Record

The toolbar at the top of the recording window is where we make changes to the recording 

settings.

USB Video Device: Choose the camera to use for your recording from the drop down list. 

Unfortunately camera names are sometimes not the same as the model of camera, you may 

need to ‘experiment’.

You can then choose the size of the video you are going to capture. The drop down list will 

only show what the camera is capable of capturing. This list might be affected by other 

changes you make in this toolbar.

Microphone: Choose the microphone you wish to use for recording. This does not have to be 

the microphone in the video device you are using.

Recording Layouts

I Can Present has a three main layout options to choose from, not just the chroma key 

feature. It can therefore be used in a number of ways to create video presentations. The 

layouts are accessed through the drop down menu

Chroma Key (Green Screen)

The chroma key option is used when you 

want the images in your slideshow to 

appear behind you during the presentation. 

To use the chroma key option, you will 

require a chroma key screen. 

Chroma key is explained later in this guide. 

Unfortunately there are not a set of rules as 

all environments are different, but useful 

tips should make things easier. Click here 

for more information on chroma keying.

When this option is selected, the chroma 

key settings are displayed.
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The slides will appear to one side of the video and the first slide will be displayed in the live 

video feed. The backgrounds 

supplied with I Can Present will 

be automatically sized to fit the 

available space. 

The green screen backdrop 

needs to be well lit. It can be any 

colour you want, but you have to 

remember that if the background 

colour is for example brown, 

then other colours close to brown 

would be replaced with the 

background picture, skin colours 

for example as shown in the 

picture opposite.

Use the colour picker to select the colour you wish to replace.

• Click the Pipette tool, the mouse pointer ill be replaced.

• Move the Pipette tool to the preview window. Move it around inside the window and notice 

how the colour in the colour well next to the pipette tool changes. 

You need to choose a colour that is as close to that of the green screen. You may have to 

reselect the colour a number of times to get one that ‘keys’ well. The background picture 

from slide 1 will replace all the areas close to the green colour in the live feed preview 

window.

Try to remove all the green background colour by using the Green Tolerance slider. If you 

have this a long way across to the right, it might be a good idea to use the Pipette tool to try a 

different shade of green or look for some other cause such as poor or non uniform lighting. 

You can also place your presenter into the shot to see what effect they have. The Grey 

Tolerance slider can be used to try to blend your presenter into the scene. As we have already 

indicated, there are no presets its a bit of ‘trial and error’, but you should be able to get a 

good key very quickly.
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Split Screen

This option is similar to what you often see 

on TV when a presenter is doing an outside 

broadcast. In one part of the screen you 

have the presenter and in the other part the 

picture or weather forecast they are 

presenting about. 

The split screen can be either have the 

video on the left or right. No chroma key is 

used for this setting.

Picture in Picture

This option is similar in some ways to the Chroma key option but instead of the presenter 

being placed fully in front of the background slide they appear in a window. No Chroma key 

is required for this feature. This is ideal for using with PowerPoint slides.

PowerPoint slides can be exported as PDF files. This option can be found under the Save As 

menu in PowerPoint.

Once the PDF file has been saved, you can import it straight into I Can Present as explained 

in the section dealing with Import from PDF.

Script - Teleprompt

Your script will appear in the teleprompt on the right side of 

the window when you are recording. 

Use the Script Speed slider to adjust the speed of the text. 

Moving it to the right increases the speed while moving it to 

the left decreases the speed of the scrolling text.

You should alter the speed of the scrolling text until you can 

comfortably read it as it appears in the grey rectangular box 

at the top of the teleprompt. 

To alter the size of the text in the teleprompt area, drag the 
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orange splitter bar, to either the left or right to adjust the relative sizes of the preview and the 

text in the teleprompt. This does not affect the size of the exported movie.

Recording

Once you have set up everything you are finally ready to start recording.

1. Click on the record button at the bottom of the window to start 

recording.

2. An explorer window will open allowing you to choose the location for the file to be saved 

to and give the project a name. 

3. The countdown timer will begin as soon as you confirm the Save location, so that you 

can be ready to start your presentation.

Once the countdown timer has completed, your first slide will appear in the preview and 

alongside it the script. The script will scroll up the right hand side of the screen. 

As the script enters the grey target box you should begin speaking. When you get to the end 

of the script for the first slide the script prompt will stop and will not continue until you press 

the left hand mouse button. The recording does not stop.

When the left hand mouse button is pressed the presentation will continue to the next slide 

and the script for this slide will now begin to scroll up into the grey target box. You will need 

to do this for each slide.

If nothing happens when you click the mouse, then make sure your mouse pointer is either in 

the preview or teleprompt areas of the screen.

At the end of the presentation, press the Stop button.
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Exporting a Movie

I Can Present automatically exports WMV video files with an .wmv file extension. These files 

will load straight into Windows™ Movie Maker or other compatible Windows applications.

As soon as a recording is complete, I Can Present finishes saving the movie file to the 

location chosen and will show a window where you can choose to either; 

• Play the video you have just captured, 

• Show the location of the movie file in a folder.

• Upload to YouTube

• Click Done to return to the Capture screen
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Loading and Saving Files

Saving an I Can Present File

You should save your project files as often as possible. Each project file saves the details for 

each slide, the symbols and their positions as well as any script. 

Note: the project files do not save any recorded video. 

Choose File > Save or Save As... from the menu bar.

A Save As dialogue will open allowing you to choose the location to save your file to and 

name the file.

I Can Present files have the file extension .ksicp

I Can Present files can only be used by the I Can Present application for further editing.

Opening an I Can Present File

Either:

1. Load the I Can Present application.

2. Either choose File > Open… or use the File > Recent Files submenu to choose a 

recently saved file.

3. If you select Open… a filer window will open allowing you to navigate to and select the 

file you wish to load.

4. Choosing the Recent Files option presents a list of files that have recently been saved 

from I Can Present. 

5. Select the file you wish to use from the list.

6. It will then load into I Can Present and you can continue working.

or

• Double click on the I Can Present file. The I Can Present application will launch and then 

load the chosen file.
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Chroma Key

The chroma key feature allows you to film your subject in front of a chroma key screen so 

that the slides will appear behind the subject, creating a professional looking presentation.

You will need to light your subject correctly to get the best results, and of course ensure that 

your subject is not wearing the same colours as your background chroma key screen. For 

example, if you are using a green backdrop then they should not be wearing a green shirt.

I Can Present displays a real time preview of the recording with the chroma key effect. This 

helps ensure that you have the correct set up prior to the recording.

1. Select the Chroma Key layout from the toolbar 

2. Using the pipette tool choose the colour from your preview window that you wish to use 

as the background key.

The colour selected will appear in the colour swatch.

You will now see that the areas with colour you have chosen now display the first slide in your 

presentation.

You might also notice that the picture is noisy, that is to say there might appear to be some 

interference or picture break up. This is usually because of poor lighting.

Tolerance

The Tolerance slider enables you to set a tolerance for the chroma key colour. Ideally you 

want to set this as small as possible so that all of the background is shown. If you set it too 

high you may find that some of the foreground subject starts to disappear too.

Smoothness

The Smoothness slider enables you to smooth off the edges around the foreground subject 

which helps it blend more smoothly into the background.

There are no real rules for using these sliders, the settings very much depend on how you 

have set up your subjects for recording.
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Chroma Keying Explained

Chroma keying is a technique for mixing two images together, in which usually a single 

colour from one image is removed, or made transparent, revealing another image behind it. 

The technique is also known by other names, green-screen, blue-screen, colour keying and 

colour-separation overlay. Used extensively in the film industry for special effects, it is also 

seen everyday, such as in weather forecast broadcasting. The presenter appears to be 

standing in front of a large map, but in reality they are stood in front of a large blue or green 

background in the studio. Different weather maps are added on those parts in the image 

where the colour is blue or green. Blue and green are considered the colours least like skin 

tone.

The illustration below demonstrates the effect that can be achieved.
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Blue Screen or Green Screen?

Blue screens were used as the keying colour as it is complimentary to human skin tone. In 

the film industry it is also tied to the fact that the blue emulsion layer of film has the finest 

crystals and thus good detail and minimal grain, in comparison to the red and green layers of 

the emulsion.

In the more recent digital world however green has become the favoured colour. This is 

because digital cameras retain more detail in the green channel and it requires less light than 

blue. Green also has a higher luminance value than blue and in early digital formats the green 

channel was sampled twice as often as the blue, making it easier to work with.

The choice of colour is up to the effects artists and the needs of the specific shot, obviously 

dependent on what the characters are wearing or how they are coloured. In more recent 

times, the use of green has become dominant in film special effects. The green background is 

preferred over blue for outdoors filming where the blue sky might well appear in the frame 

and could accidentally be replaced in the process. Although green and blue are the most 

common, I Can Present has been designed to allow the user to choose any colour to key 

against.

For the purposes of this manual we will refer to it as green-screen.

Lighting

The biggest challenge when setting up a green-screen is getting the screen evenly lit and to 

avoid both shadows and hotspots, (areas which are brighter than the rest of the screen). An 

evenly lit screen gives a narrow colour range to be replaced, resulting in much more accurate 

keying. If you have shadows, it would present itself as a darker colour to the camera and 

might not register as part of the matte.

Object

Light

Light

Light

Camera

Green Screen

Example Lighting Diagram
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When choosing a chroma key screen, try to use materials which are not shiny. A shiny 

surface will have areas that reflect the lights making them appear too bright. It is better to 

choose a matt surface as this will diffuse the reflected light better and have a more even 

colour range.

Hot Spot
Cold Spot

Shadows
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Appendix

Links to Support Resources and Updates

I Can Present – Support Resources and Updates

Deploying I Can Present Over a Network

System administrators who wish to deploy the I Can Present MSI over a network need to take 

the following into consideration.

If you wish to deploy the application pre-registered then you may require an MST (Microsoft 

Transform) file. This can be created using our online MST tool.

Each client machine will need to have the following pre-installed.

• A minimum of Windows Installer 3.1

• .NET Framework 4.0 Client Profile

These are available as downloads from Microsoft’s website.

Click here for more information on deploying the .NET framework.

ACKNOWLEDGEMENTS
Microsoft Windows, Microsoft PowerPoint, and Adobe PDF are trademarks, all trademarks are 

acknowledged.

 I Can Present Green Screening - Windows ! Page 31 

https://www.kudlian.net/products/weather
https://www.kudlian.net/products/weather
http://www.microsoft.com/downloads/details.aspx?FamilyID=889482FC-5F56-4A38-B838-DE776FD4138C
http://www.microsoft.com/downloads/details.aspx?FamilyID=889482FC-5F56-4A38-B838-DE776FD4138C
http://msdn.microsoft.com/en-us/library/cc160717.aspx
http://msdn.microsoft.com/en-us/library/cc160717.aspx


VividPro
D i g i t a l  C a m e r a

48MP
Max /2.7”TFT-LCD

Never-Ending Learning Innovation



2



3



4



5



6

LED Light

Flash

Optical Lens

Strap Holes



7

Speaker  
Button



8

Full battery power Medium battery power Low battery power



9



10



11



12

A



13



14



15



16



17



18



19



20



21



22



23



24



25



26

Image Sensor 8MP CMOS Sensor

Image Resolution (48MP) 8000x6000, (30MP) 6400x4800, (24MP) 5600x4200, (18MP) 4896x3672, 
(16MP) 4608x3456, (8MP) 3264x2448, (7MP) 3072x2304, (5MP) 2592x1944, 
(2MP) 1600x1200.

Video Resolution 4K, 2.7K, 1080P, 720P

File Formats JPEG (Still Image), AVI (Video)

Speaker Yes

External Memory HCSD Class 6 or Higher Card (up to 64GB)

Screen 2.7 inch TFT-LCD

Zoom 8x Digital Zoom

Exposure -3.0EV ~ +3.0 EV

White Balance Auto, Daylight, Cloudy, Tungsten, Fluorescent

ISO Auto, 100, 200, 400

Scene Auto, Sport, Night, Portrait, Landscape, Backlight, Party, Beach, High Sensitivity
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Flash Auto Flash (flashes as needed), Manual Flash (flash always on), No Flash

Self-timer Off, 2 seconds, 5 seconds, 10 seconds

Interface USB 2.0

System Requirements Windows XP, Vista/7, Mac

Battery Lithium-Ion
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